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Preface

This Document

This document provides documentation of MODSIM III as of December 1996 for all im-
plementations.  The MODSIM III Reference Manual was revised and republished at the
same time as this revision.

MODSIM III Documentation

There are four documents pertaining to MODSIM III:

• MODSIM III Reference Manual - The language reference.  Contains informa-
tion about the syntax and structure of MODSIM III as a programming language.
Also covers object-oriented programming, simulation, graphics and I/O.

• MODSIM III Tutorial - Provides a broad overview of the language features of
MODSIM and then concentrates on the object-oriented programming and simula-
tion capabilities in MODSIM.

• MODSIM III User's Manual - This document.  Contains information about:
mscomp, the compilation manager;  MODBENCH, the development environ-
ment under Windows; MODSIM compiler options; and debugging MODSIM.

• SIMGRAPHICS II User’s Manual - This manual contains information about
SIMGRAPHICS II, the integrated graphics development and animation environ-
ment for MODSIM III.

This manual is organized to discuss the following topics:

• mscomp:  The MODSIM III development environment under UNIX.  How to
configure and use it to simplify the compiling and linking of MODSIM executa-
bles.

• MODBENCH: The MODSIM III development environment under Windows.

• Debugger:  The MODSIM III debugger under Windows and Unix.

• Command Line Interface to MODSIM III Compiler:  How to use the com-
mand line interface.

• Standard Modules:  A listing of MODSIM III's standard modules.

Early MODSIM users will note that some material which previously appeared in this
document has been moved to the Reference Manual.
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Free Trial & Training

MODSIM III is available exclusively from CACI Products Company.  MODSIM III can
be sent to your organization for a free trial.  We provide everything needed for a com-
plete evaluation on your computer: software, documentation, sample models, and imme-
diate support when you need it.

Training courses in MODSIM III are scheduled on a recurring basis in the following lo-
cations:

La Jolla, California
Washington, D.C.
London, United Kingdom

For information on free trials or training, please contact the following:

In the U.S. and Pacific Rim: In Europe:

CACI Products Company CACI Products Division
3333 N. Torrey Pines Ct. MECC Business Center
La Jolla, CA 92037 G. Martinolaan 85; 8th Floor
(619) 824.5200 6229GS Maastricht, The Netherlands
Fax (619) 457-1184 43 670780

Fax 43 670200
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1.  MSCOMP — A Modular Compilation      
Manager Under UNIX

1.1  Background

mscomp is a program which manages the MODSIM compile process on UNIX operating
systems.  This chapter describes how to use mscomp.  If you are working under Micro-
soft Windows, use the MODBENCH development environment instead of mscomp.  See
the next chapter for more information on MODBENCH.

mscomp manages separate compilation of MODSIM programs consisting of multiple
modules by determining which modules have been edited since the last compilation and
recompiling only those modules and any other modules which depend on them.  This
process is accomplished automatically using information in the MODSIM program and
the machine's file system without need for “make” or project files to describe the process.

A MODSIM executable program is produced in several distinct steps.  In the simple case
of a single main module, the following must be done:

• The MODSIM source code file, Mxx.mod, is given to the MODSIM compiler
which produces the following files:

Mxx.cpp C++ code

Mxx.err error file { optional }

Here xx is the name of the MAIN module.  Naming conventions will be covered
more fully shortly.

• The generated C++ code is compiled using the system's C++ compiler.  This re-
sults in a file Mxx.o.

• The object file produced by the C ++ compiler is linked with the MODSIM III li-
brary producing an executable file.  This is named xx .

If the program is composed of a number of modules, the process is more complex.  Be-
cause of the many steps involved in the C++ compile and link process and the need to
perform the C++ compile and link with particular options on each machine type, the
mscomp compilation manager has been provided to automate these steps.

The current version of the MODSIM III environment has been designed to allow you to
keep each project in a separate subdirectory with its own mscomp.cfg configuration
file, if desired.  Of course, you can also keep several projects in one subdirectory.
mscomp will not have any problems keeping track of projects. All MODSIM system
files reside in their own directories.
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Note: File and subdirectory names are case sensitive on UNIX systems.

1.2  MSCOMP's Configuration File

A configuration file called mscomp.cfg must exist in any directory in which mscomp
will be used to perform compiles.  If such a file does not exist, mscomp will offer to
write a default file into the directory.

The mscomp.cfg file contains configuration lines which determine where mscomp will
look for files needed to compile a project and which compile options will be in effect.
Each line starts with a keyword followed by a ">" and a space.  This is followed by the
information for that line. After a further space and a "’"  you can place any comments.
Lines which contain path information for directories follow these conventions:

• A single period “.” indicates the current directory.

• Two periods “..” indicate the directory above the current one.

• Multiple paths can be indicated for libraries only.  They are separated by a “+”.
No spaces are allowed.

• The paths can end with or without a terminating forward or backward slash.

You should attempt to keep the path names short by using relative paths or by using short
directory names where possible.  The paths mentioned in the configuration file are used
to build command lines for system utilities such as compilers and linkers.

Here is how the default version  mscomp.cfg file looks on a Unix system:

x.x.x '- Version of 'mscomp' and MODSIM III Compiler
MSEXEC> /modsimx.x.x/bin '- MODSIM III system directory
MSLIB> /modsimx.x.x/lib/modsim '- MODSIM III library/import
directory(s)
DEF> . '- Definition source module directory
IMP> . '- Implementation source module directory
OBJ> . '- Object file directory
VIEW> project '- database filename for debug

SR> ON '- Subrange and subscript checking
PTR> ON '- Pointer checking
REF> ON '- Reference variable checking
TB> OFF '- Runtime error traceback
DEBUG> OFF '- Generate debugger code
GRA> ON '- Link with graphics library
3D> OFF '- Link with 3D graphics library
SO> OFF '- Link with SimObject library
LIS> OFF '- Generate compilation listing
ERR> OFF '- Keep .err files, if any
BEEP> ON '- Audible prompts
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The first line is the version number of the current release.  This information is used by
the system to ensure that the configuration file is compatible with the current release.

The MSEXEC line contains the full path of the MODSIM system directory.  The MSLIB
line contains the full path of the MODSIM library directory.  This is the directory which
contains the header, definition and library archive files for the MODSIM system.  This
can optionally be followed by zero or more additional directories containing other proj-
ect's libraries from which you are importing.  These additional directories are separated
by the plus character '+'.  No spaces should appear between (or within) directories.

The DEF and IMP lines are the directories which contain, respectively, the project's defi-
nition module source code and the implementation source code.  These two directories
(which usually will be the same directory) may be thought of as the "current working di-
rectory".  The OBJ line is the directory in which to place the object files generated from
the compilation.  Each of these must be a single directory path.  Only the library line al-
lows the '+' notation.

When mscomp generates the default mscomp.cfg file, it attempts to insert correct in-
formation about the current installation in the MSEXEC and MSLIB lines.  It does this by
searching the system's path looking for the MODSIM system files.

Following the path information in the mscomp.cfg file are a number of lines which de-
scribe system options.  Note that the choices here are ON or OFF.

The SR option specifies whether the system will enable runtime checking to ensure that
subscripts and subranges are never assigned any value which would be out of bounds for
that type.

The PTR option is not used in MODSIM III.

The REF option specifies whether the system will check object and record reference val-
ues when they are dereferenced (e.g. as ASK statement).

The TB option specifies whether the compiler generates code to print a traceback of the
current calling sequence when a runtime error occurs.

The DEBUG option specifies whether the compiler generates code to allow debugging.

The GRA option specifies whether the generated code will be linked with the
SMIGRAPHICS II libraries.

The 3-D option specifies whether the generated code will be linked to a Open GL com-
patible library.
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The SO option specifies whether the generated code will be linked to a set of library
routines specifically designed for simulation programming referred to as SimObject.

The LIS option is not used in MODSIM III.

The ERR option specifies whether the compiler will keep .err files, if any.  These are
files which, for each module compiled, list the line number, column number and error
message for each compile time error encountered.  These files can be used with configur-
able text editors to place the cursor directly on indicated errors to be edited.

The BEEP option specifies whether mscomp will be silent or will emit warning beeps.

You may edit the entries in the file mscomp.cfg, as required, using any text editor, or
use mscomp to set the configuration options.

1.3  Files

The following naming conventions are used by the MODSIM compilation manager.
Note that on other than PCs, file names are case sensitive.  On all machines, module
names are case sensitive:

Module Name File Name
MAIN MODULE Alpha MAlpha.mod
DEFINITION MODULE Beta DBeta.mod
IMPLEMENTATION MODULE Beta IBeta.mod
C++ code to support Beta Beta.cpp

It is important that the above conventions are followed since they are used by the com-
pilation manager to perform compiles and links.

1.4  Using MSCOMP

mscomp's Main Menu offers the most frequently used options:

     MAIN MENU

(M)ake project

(E)valuate status

(O)ther compile/link options

(C)onfiguration

(H)elp

(Q)uit

(M) This selection will prompt for the name of the main module of the project to be
compiled.  The name must be provided without the preceding “M” and without the
succeeding “.mod” file extension.  The program may include simply a main
module or it may have a main module, definition and implementation modules
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(MODSIM and/or C++).  The compilation manager will determine which files are
required to build this project (based upon imports into MAIN and then their im-
ports and so on).  The manager determines which modules are required by ob-
serving certain naming conventions.  If any module imports from a DEFINITION
module, then the manager will see if an IMPLEMENTATION module and a C++
file of the same name exist. If so, it will assume they are required for the project.

MAIN MODULE abc;
...
FROM foo IMPORT bar, .... ;
...

Upon examining main module abc, the manager knows that this project requires
definition module foo (assuming that foo is not a system library definition
module - see below for explanation).  The manager will see if Dfoo.mod exists,
and then it will check for the existence of Ifoo.mod and foo.cpp.  If either or
both of these do exist, it assumes they are required for the project.

Once the required modules are identified, the compilation manager ascertains
whether any of these modules require compilation.  A source code module will
require compilation if:

• Its date is later than the corresponding object file.

• Any module on which it depends has a later object file date than the mod-
ule's corresponding object file.

• Any module on which it depends is going to be scheduled for recompila-
tion this time.  Once all modules which require recompilation have suc-
cessfully compiled, the manager will schedule a link of all modules
required for the project.  This final step produces an executable program.

(E) This selection will perform a project evaluation starting from a MAIN module.  It
works exactly like the first option except that it merely reports to you which
modules need to be compiled.  It does not actually schedule any compiles.

(O) Selecting “O” from the main menu will take you to the “OTHER OPTIONS
MENU”.  The menu provides many compilation and linking variations that are use-
ful in managing large and small projects.  These are explained below.

(C) Item “C” displays the “CONFIGURATION MENU” which allows you to view and
change the current configuration settings as specified in the configuration file.

The following describes the subsidiary menus of mscomp.  Each menu page has a
(H)elp selection which briefly explains the options on that particular menu.
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1.4.1  Other Options Menu

(C) This selection will identify the modules required for a project from the MAIN
module you specify.  A full description is given under MAIN MENU option “M”.
Once all such modules are identified they will all be scheduled for compilation.
No date checking will be performed.  This option forces compilation of all mod-
ules whether or not they are out of date.  This comes in handy if you have previ-
ously compiled all or some of the modules with certain options switches set, but
now want to have them turned off to speed up code and reduce executable size.
No link will be performed.

(S) This item will compile an individual MAIN, DEFINITION, IMPLEMENTATION or
C++ module.  You will be required to specify which type of module is to be
compiled (“M”, “D”, “I”, “C”, respectively) and then provide the name of the
module without the preceding qualifier or the succeeding file extension.  This
option can be used to compile one particular module with a different set of com-
pile options than the rest, or to simply check the module for syntax errors.

(P) This selection will force the compilation of all modules specified in a project file.
This option functions much like item “C” except that the compilation manager
will not automatically determine which files are to be compiled.  Instead, this in-
formation is taken from the modules listed in the project file whose name you
specify.  The project file name should be entered without the succeeding file ex-
tension (all such files must have a “.prj” file extension).  The format for project
files will be explained below.

(L) This selection will force a link of all modules required for a project.  The list of
modules required will be determined as described in MAIN MENU option “M”.

(K) The “K” option will also force a link of all project modules.  These modules are
specified in a project file rather than being determined from a main module as in
“L” above.

(M) Option “M” performs like MAIN MENU option “M” except that the modules are
specified in a project file rather than being determined from a main module.  De-
pendency checking and date checking are also performed to ensure that all re-
quired modules are re-compiled.

(A) The “A” selection uses both a MAIN module and a project file.  The compilation
manager will determine from the main module which modules are required for
the project and whether any of these modules require recompilation.  All of these
modules will be scheduled for linking into the executable.  In addition to these
modules any modules specified in the project file by the “O” or “L” modifier will
also be linked into the final project executable.  This allows specification of ob-
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ject and/or library files for use in projects.  Items in the project file preceded with
“D”, “I”, “M” or “C” will not be scheduled for compilation and/or link.

1.4.2  Configuration Menu

(V) Option “V” displays the current configuration for this invocation of the compila-
tion manager.  Initially the configuration comes from the mscomp.cfg file in the
current directory.  The various settings and directories may be temporarily
changed for an individual run or permanently edited by using options “C” and “M”
described below.

(C) Option “C” allows you to  change switch settings for compiler options such as
reference checking, range checking, traceback, etc.  These changes will persist
only for this invocation of the compilation manager unless you specify that they
be saved.  If any options are changed, you are asked if the changes should be
permanent (i.e., overwrite the configuration file in the current directory).  If so,
the current settings will be saved.  You may change these options as many times
as necessary during any particular session.

(M) The “M” selection allows you to modify the directory specifications for the com-
pilation manager.  These changes persist only for the current run of the manager
unless you indicate that they be saved in the configuration file.  If modifications
are not saved, these directories will revert to those specified in the configuration
file upon subsequent runs.

1.5  Command Line Operation

Most of mscomp's compile/link/evaluate menu options may be invoked from the com-
mand line.  If you will not need to use the menu options at all or will want to run the
compiler in batch mode, a flag may be given to mscomp to indicate this.  In batch mode,
compilation will not stop upon errors or wait for keyboard input.  Output will continue to
go to the screen unless redirected to a file or printer.  The command line switches parallel
the menu selection keys as much as possible.  In command line mode, mscomp uses the
settings specified in the mscomp.cfg file unless they are explicitly overridden by one of
the command line options.

To use mscomp from the command line, invoke it followed by one or more of the fol-
lowing options on the command line: mscomp

<main> mscomp followed by the name of a main module (without the preceding
“M” or the succeeding “.mod”) will determine the modules required to
build an executable from this named main module, determine which, if
any, need to be recompiled, schedule their compilation and finally per-
form a link, producing an executable program.  This is identical to select-
ing option “M” from the MAIN MENU.
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-v Performs an evaluation of which modules for a particular main module
will need recompilation and reports the result.  Same as “E” from MAIN
MENU.

-c <main> Compile all modules required for the project specified by main module
<main>.  Same as selecting “C” from OTHER OPTIONS MENU.

-s{m|d|i|c} <module name>
This switch (a “-s” followed by one of “m”,”d”,”i” or “c”) will perform
a single module compilation of <module name>.  Same as “S” item on
OTHER OPTIONS MENU.

-p <project> The “-p” switch followed by the name of a project file without
the “.prj” suffix will force compilation of all modules listed in
<project>.  Same as “P” item on OTHER OPTIONS MENU.

-l <main> “-l” switch forces a link of all modules required for the project specified
by <main> module.  Same as “L” on OTHER OPTIONS MENU.

-k <project> This switch forces a link of all modules specified in the file
<project>.prj. Same as “K” on OTHER OPTIONS MENU.

-m <project> This switch causes an evaluation of the dependencies of the mod-
ules specified in the <project>.prj file.  Any modules which require
compilation will be scheduled and then a link on all modules will be per-
formed.  Same as “M” option of OTHER OPTIONS MENU.

-a <main> <project>
This switch will evaluate all modules required from <main> module,
schedule any modules requiring compilation and perform a link of all such
modules plus any “O” or “L” modules specified in the <project>.prj
file.  Same as “A” on OTHER OPTIONS MENU.

-u <project> This switch will assess the modules listed in project file
<project>.prj and report which modules require compilation.  Same
as “U” on OTHER OPTIONS MENU.

-e Specifies that the system will check for NILOBJ reference values being
passed in formal parameter lists.

-l Specifies that the compiler will emit a listing of compiled code.

-b Specifies that mscomp will be run in batch mode.  After performing the
indicated actions it will not return to the main menu.  Instead it will ter-
minate.
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1.6  Project Files

A number of options are designed to be used with project or script files which contain a
script in the following format:

' This is project file Alpha.prj

' last edited  6/14/95

 I Beta

C Delta

M Alpha

O other

L libstuff.a Unix

The project file must be in the following format. It does not allow a “free” format.  The
first character on each line specifies the type of module to be compiled.  The choices are
M for main,  I for implementation, C for C++ source files, O for object files and L for li-
braries.  The letter must be in uppercase and must be followed by a space.  Comments
may be included if an apostrophe is the first character on a line.

Where the first character is M, I, or C, the second entry is the full module name, not the
truncated file name.  The module name is case sensitive.

Where the first character is O, the second entry is the full path for an object file (without
the file extension) which is to be linked into this executable. Unix systems assume an
“.o” extension.

Where the first character is L, mscomp expects the full path and extension for a library
file.  The extension information is required since some systems will have several versions
of system libraries whose names differ only in the extension.

mscomp expects project file names to end with the extension “.prj”.

1.7  Checking Out the Installation

Program “MErrors.mod” demonstrates how errors are handled by the compilation
process.  Program “Mhello.mod” can be used to verify proper operation of the compile
process.  It should produce an executable called hello which prints out a brief message.

See the sample programs in the demos directory of the distribution disk for more exam-
ples of MODSIM code.  The file README, in that directory, explains what each one does.
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2.  MODSIM III Development under Microsoft
Windows

The chapter covers the following topics:

• Overview of MODSIM III for Windows

• Hardware and Software Requirements

• Use of MODSIM III Workbench to Manage MODSIM III projects.

2.1 Overview

As in the previous release, full MODSIM III functionality is provided in the context of
Microsoft Windows for PC computers.  MODSIM uses the virtual memory manager of
Microsoft Windows to run large models.  When used with a fast PC, its performance for
both compilation and simulation runs is comparable with many Unix workstations.
MODSIM III system libraries have been compiled to take advantage of 32 bit memory
access.

2.2 Hardware and Software Requirements

MODSIM III can be run on a large number of PCs because it does not make special
hardware demands beyond those of typical “high end” Windows systems.

• 80486 processor or greater

• 16 MB of system memory minimum.  32 MB recommended

• 27 MB of available hard disk space minimum

• Microsoft Windows 95 or Windows NT 3.51 (or greater)

• Microsoft Visual C++ 4.x

• On all systems, a larger monitor is preferred.  It should be 17" or greater and have
a display card capable of operation at 1,024 x 768 resolution with 256 colors.

2.3  Using MODSIM III Workbench to Manage Your Projects

MODSIM III Workbench is an integrated program environment for conveniently organ-
izing, creating, compiling, running and debugging your MODSIM III programs.

This overview follows the Workbench's menu choices.  Where menu choices open dialog
boxes, these dialog boxes are described separately at the end of the walk through of the
main menu choices.

2.4  Organizing Your Program with a Project

The project is the basic organizing unit of MODSIM III Workbench.  A project records
all of the relevant information about the program you are creating:  its name, its location,
what files are used to build it, current compilation options, etc.
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Typically, opening a project is the first step in using MODSIM III Workbench.  Only one
project can be open at a time; this is the current project.  MODSIM III Workbench
automatically saves any changes you make to the current project.  This occurs when you
leave MODBENCH, when you explicitly close the project or when you open another
project.

The Project menu supports a number of operations on the current project, such as build-
ing the project and running or debugging the program.

2.5  Creating a Program

The easiest way to create a program is to use the Project New menu choice.  It offers
you the option of creating a new subdirectory for your project and of  creating a new
MAIN Module.

Once this has been done, you can use the MODSIM III Workbench editor to edit, create,
or view program files.

The File menu offers commands to open an existing file for editing, to save changes to a
file, to create a new editing window, etc.

If you want to use the editor of your choice, you can use the Options menu Tools option
to install your own editor.  The editor can then be launched from the Tools option.

2.6  Compiling a Program

MODBENCH allows you to compile a single module, but usually it is easier to select
Project Build instead of Project Compile Module.  Build will compile all modules which
need to be compiled and will then link to build an executable program.

2.7  Running a Program

After your program compiles successfully, you can execute your program from
MODSIM III Workbench by choosing Execute from the Project menu.

2.8  Text Input/Output

MODSIM has several statements that input and output text:  INPUT, OUTPUT, PRINT.
MODSIM also prints messages in response to runtime errors.

In the Windows version of MODSIM, these statements are output to a console window
that is created automatically. You can use the scrollbar in Windows NT to review previ-
ous output.
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2.9  Project Menu

The Project menu offers commands for manipulating the current project.

2.9.1  Project / New

Presents the New Project dialog, which lets you create a new project.  After specifying
the new project and pressing OK, the new project becomes the current project.  The proj-
ect which is currently open is automatically saved and closed.
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Note: This dialog is derived from the standard Windows file browsing dialog box.  Its
use and operation should be familiar to the Windows users.

2.9.1.1  Project Name

All project information is stored in a file specified by the project Project Name field,
which is given the extension .prj by the user or by the system if the user omits it.  The
executable file generated by MODSIM III Workbench for this project will have the same
name, with the extension .exe.  For example, if the project name was Sample.prj, the
executable will be called Sample.exe and the MAIN module will be named Sample.

The project file and all of the related source files will be created in the directory specified
in the browsing window of this dialog box.  To create a new directory for your project:

1. Browse to the location in which you want the directory to be created.

2. Enter the name of the new directory in the New Subdirectory field.

The new directory is created and you are placed in the new directory.

Every MODSIM III application has one main module.  The Main Module field specifies
the name of the main module.  The main module name can contain only letters and num-
bers, and must start with a letter.  Capitalization is important.

For example, if the Project Name which was entered was VegetableSoup, the main
module which is created would have this first line:

MAIN MODULE VegetableSoup;

The project file would be VegetableSoup.PRJ and the main module would be in the
file  MVegetableSoup.MOD.

Note: MODSIM requires a strict relationship between a module name and the name of
the file containing the module.

2.9.1.2  MODSIM III Module and File Naming Conventions

MODSIM III's compiler and utilities expect that a certain naming convention will be
used for files which contain modules.  MODSIM source files are expected to have the
extension .mod.

The file name is composed by preceding the module name with an M for a MAIN mod-
ule, D for a DEFINITION module, and I for an IMPLEMENTATION module.  The
file name must match the module name exactly, and is case sensitive.  The .mod exten-
sion is then added.  The following examples illustrate the process.

MAIN MODULE Alpha      Malpha.mod

MAIN MODULE AlphaNumeric      MAlphaNumeric.mod

IMPLEMENTATION MODULE BackRack      IBackRack.mod

DEFINITION MODULE Beta      DBeta.mod
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2.9.1.3  Project Type

There are four project types to choose from:

• • Graphics Application

• • Text Application

• • Graphics Only Application

• • Static Library

Choose Graphics Application if you want to use MODSIM's graphics capability (i.e.
SIMGRAPHICS II) and need to use OUTPUT/INPUT statements. Choose Text Applica-
tion for text only applications which do not use graphics. This will make your executable
smaller.  Choose Graphics Only Application if you want to use graphics and do not want
to use OUTPUT/INPUT statements.

2.9.2 Project / Open

Presents a File Open dialog that lets you select the project to open; this becomes the cur-
rent project.  Projects are stored in files with the .prj extension.  The project which is
currently open is automatically saved and closed.

2.9.3  Project / Close

Closes the current project, saving its current state.

2.9.4  Project / Compile Module

Compiles the module displayed in the topmost editor window of MODBENCH’s editor.

2.9.5  Project / Build ...

Ensures that all modules used in the current project are compiled, and creates the execu-
table.  MODSIM III Workbench only recompiles a module if necessary.  Build and Re-
build will build an application in Debug or Release mode depending on the option
currently selected in the Project Options dialog.  A project may be built of a mixture of
modules which were compiled with and without debugging.

If errors are found during the compilation phase of the build process, the errors will be
noted in the output window and the system will continue to compile the remaining mod-
ules which require building.  The link will be canceled since at least one module had er-
rors.  You can press the F4 key to review each error.  See View Next Error.

2.9.6  Project / Rebuild All ...

MODSIM III Workbench uses a sophisticated algorithm to detect when it can avoid re-
compiling a module.  However, there are times when it is desirable to force a compile of
all modules.  This might occur after program development and debugging when all mod-
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ules are compiled with error checking off.  The Rebuild All command forces MODSIM
III Workbench to recompile all modules.

2.9.7  Project / Stop Build

Select this command to terminate a build in progress.  The build process will stop at the
end of the current step, so there may be a delay between the time this option is selected
and the termination of the build process.  An acknowledgment will be displayed in the
output window when the build process terminates.

2.9.8  Project / Execute ...

The Execute command runs the program, if it exists.  If the program does not yet exist,
you will be asked if you would like to build the application.

2.9.9  Project / Debug ...

The Debug command runs the program in interactive debugging mode.  The main mod-
ule and any module which you would like to debug must have been compiled with de-
bugging support enabled.  The program will stop at the first executable line.  From there,
you can examine variables and types, set breakpoints, execute the program line by line,
or examine the execution stack.  For further information, see Introduction to Debug-
ging with MODSIM III, use the Help option for debugging, or press the Help button
once you are in debugging mode.
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2.10  Project / Settings ...

Often, you want to use different settings while debugging than for the final release.  For
example, during debugging you may want all checking turned on, to catch errors.  For
the final release, you may want checking turned off, for speed.

There are a number of settings for controlling the compilation process.  If Debug Specific
is selected, any change will apply to the debugging set of options;  if Release Specific is
selected, any change will apply to the release set of options; if Common to Both is se-
lected, any change applies to both the debugging and release sets.

Debug Specific:

When checked, MODSIM III enables interactive debugging of a running application.
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No Debugging:

When an error occurs, MODSIM III displays no debugging information.

Minimal Debugging:

When an error occurs, MODSIM III displays the only a trace of the calling routine that
resulted in the error.

Partial Debugging:

When an error occurs, MODSIM III displays the trace of the calling routines that resulted
in the error, and allows examination of the data local to that routine.  This is useful when
you wish to allow the use of an inherited method, but not source level access.

Full Debugging:

When an error occurs, MODSIM III displays the sequence of calls that resulted in the
error.  In addition, breakpoints can be set and stepping through source code is available.

Warning Messages:

Warning messages and their levels are not implemented at this time; the program defaults
to none.
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Subrange Checking:

When checked, MODSIM verifies all array references at runtime, reporting an error if it
detects an out-of-bounds index.  This option also controls bounds checking of enumer-
ated types and subrange types.

Reference Checking:

When checked, MODSIM verifies at runtime all references to objects to ensure that the
object is valid.  An error is reported if a problem is detected.

2.10.1  C++ Tab

Compiler Options:

In ordinary use, you will not need to change the C++ Compiler Options.  In fact they
should normally not be changed since MODSIM III’s libraries expect that certain of the
options are selected.  Consult your C ++ compiler documentation for more information
on these switches.
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Preserve C ++ Files:

MODSIM III works by compiling a MODSIM program into C++, and then compiling the
C ++ code into object code.  Ordinarily, the intermediate C++ files are deleted after
compilation, but if this option is checked the intermediate C++ files are retained.

Generate Indented C++ Code:

When checked, MODSIM produces a C++ code which is indented.

2.10.2  Directories Tab

Project Definition Module Directory:

This field specifies one (and only one) directory in which the MODSIM Definition mod-
ules for the current project can be found.  The “.” specifies the current directory, while
“..” specifies the parent directory.
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Project Implementation Module Directory:

This field specifies one (and only one) directory in which the MODSIM IMPLEMEN-
TATION modules for the current project can be found.  The “.” specifies the current di-
rectory, while “..” specifies the parent directory.

Project Library Definition Directory:

This field specifies one or more directories to search to find additional MODSIM DEFI-
NITION modules.  Each directory path is separated with a semicolon ‘;’.  This field
would typically be used to specify a collection of frequently used definition files similar
to the MODSIM III system and graphics files found in MODSIM’s definition directory,
but provided by the user.  Typically, the implementation code for these files has been
compiled and consolidated in a .LIB file which is specified in the link options.

2.10.3  Link Tab

 

Linker

The Linker Options field lets you specify the options passed to the linker when linking
the various modules into a MODSIM application.

The Libraries field lets you specify the libraries that will be included during the link.  If
there are multiple libraries, separate them by spaces.
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Reset will return you to the supplied default values for both the linker and libraries.

2.11  Options Menu

The Options Menu commands let you change options that affect the MODSIM III Work-
bench in general, and the current project in particular.  For example, you can change

where MODSIM III Workbench looks for executables, and you can change whether or
not the current project should be compiled with or without run time debugging checks.

The Options menu allows adjustment of the MODSIM III Workbench environment.

2.11.1  Options / Directories...

The directories listed here tell MODSIM III Workbench where to look for various
MODSIM files. The Executables directory gives the location of modsim3.exe, and
other MODSIM executables and dynamic link libraries.

The Include directory gives the location of the MODSIM header files.

The Link directory gives the location of the MODSIM runtime libraries (.lib files).
Multiple directories may be specified separated with a semicolon ';'.

The Library Definition directory gives the location of the system definition modules
(D*.mod files) for MODSIM's runtime and SIMGRAPHIC II libraries.
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2.11.2 Options / Editor...

MODSIM III Workbench provides a simple editor that you can use to create, view, and
update modules.  Use this command to customize editor behavior.  Use the Op-
tions/Editor dialog to customize the editor's settings.

The Tab Stops field sets the number of positions between tab stops.  It is not yet imple-
mented.  If Keep Tabs is selected, then when you type a tab it remains a tab. If Insert
Spaces is selected, a tab is converted into an equivalent number of spaces.

If you want scroll bars to help you move around a file, check the Vertical and Horizontal
Scroll Bars option.  Otherwise, you must use the Page-Up, Page-Dn, and arrow keys to
view portions of the file that are off-screen.

The Save Before Running Tools option will ensure that your source files which have been
edited will be saved before any compile, build or program execution.  If you want
MODSIM III Workbench to prompt you before saving, check the Prompt Before Saving
Files option.

2.11.3  Options / Tools...

This command allows you to install your own tools in the Tools menu.
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2.11.4  Options / Font...

The Font option lets you choose the font face, style, and size to use in the editor win-
dows.

2.12  View Menu

Select Line to view a specific line in the topmost editing window.

Select Next Error to view the next error, after a MODSIM compile.

Select Previous Error to view the previous error, after a MODSIM compile.

Select Toolbar to toggle the display of the Toolbar.

Select Status Bar to toggle the display of the Status Bar.
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2.13  File Menu

2.13.1  File / New 

Creates a new editing window that you can use to enter text.

2.13.2  File / Open...

Presents the File Open dialog, which you use to select a file to edit.  The file does not
have to be related to the current project.

The following options allow you to specify which file to open:
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File Name

Type or select the filename you want to open.  This box lists files with the extension you
select in the List Files of Type box.

List Files of Type

Select the type of file you want listed in the Files list:

• modsim files (*.mod)

• c files (*.c)

• project files (*.prj)

• any other files

Drives

Select the drive containing the file that you want to open.

2.13.3  File / Close

Closes the topmost editing window.

2.13.4  File / Save

Saves the topmost editing window in the same file it was initially loaded from.  If the
topmost editing window was created by New, then it prompts for a filename to save to.

2.13.5  File / Save As...

Prompts for a filename to save to, using the File Save As dialog, and then saves the top-
most editing window in that file.

The following options allow you to specify the name and location of the file you are
about to save:

File Name

Type a new filename to save a document with a different name.  A filename can contain
up to eight characters and an extension of up to three characters.  MODSIM III Work-
bench adds the extension you specify in the Save File As Type box.

Drives

Select the drive in which you want to store the document.

Directories

Select the directory in which you want to store the document.
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2.13.6  File / Print... 

The Print... dialog lets you specify how you want to print the document in the topmost
editing window.

2.13.7  File / Print Preview

The Print Preview command shows how the document in the topmost editing window
will appear when printed.

2.13.8  File / Print Setup...

The Print Setup dialog lets you change the current printer, and how the current printer
behaves.

The following options allow you to select the destination printer and its connection.

Printer

Select the printer you want to use.  Choose the Default Printer; or choose the Specific
Printer option and select one of the current installed printers shown in the box.  You in-
stall printers and configure ports using the Windows Control Panel.

Orientation

Choose Portrait (normal) or Landscape (sideways).

Paper Size

Select the size of paper that the document is to be printed on.
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Paper Source

Some printers offer multiple trays for different paper sources.  Specify the tray here.

Options

Displays a dialog box where you can make additional choices about printing, specific to
the type of printer you have selected.

Network...

Choose this button to connect to a network location, assigning it a new drive letter.

2.13.9  File / 1. Z:\modsim\....

MODSIM III Workbench remembers the last four files you edited, and lists them in the
File menu.  You can instantly Open one of these files by selecting the corresponding
menu item.

2.13.10  File / Exit

Exit saves any work in progress, and quits MODSIM III Workbench.

2.14  Edit Menu

The Edit menu provides the functionality available to all Windows programs.
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2.14.1  Edit / Undo

If the last editing command is reversible, selecting Undo will reverse it.

2.14.2  Edit / Cut

If text is currently selected in the topmost editing window, this command deletes it and
puts it into the clipboard.

2.14.3  Edit / Copy

If text is currently selected in the topmost editing window, this command copies it and
puts it into the clipboard.

2.14.4  Edit / Paste

Paste the text on the clipboard into the topmost editing window at the current cursor po-
sition.

2.14.5  Edit / Find...

Use this option to find the first occurrence of a string, after the cursor position.
Use the Find dialog to locate a specific string.

Check Match Case if the capitalization of the characters in the search string should be
considered when looking for a match.  Otherwise, characters will match even if one is
uppercase and the other lowercase.

Select Up to search backwards from the current cursor position.  Select Down to search
down from the current cursor postion.

Type the string to match in the Find What field.

Press Find Next to begin the search.  MODSIM III Workbench will beep if no matching
string is found.

2.14.6  Edit / Find Next:

Finds the next occurrence of the string most recently specified through the Find com-
mand.
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2.14.7  Edit / Replace...

Use this option to replace all occurrences of one string by another.  The topmost editing
window is scanned, from the current cursor location to the end, to find text to replace.

Type the text to search for in the Find What field.  Check Match Case if you want capi-
talization to be considered when searching.

Type the text to replace with in the Replace With field.

Find Next will select the first text after the current cursor position which matches the
search text.

If Text Matching the Search Text is selected, then pressing Replace will replace the selec-
tion with the replacement text.  Pressing Replace All will replace the selection, and all
further matches, with the replacement text.

2.14.8  Edit / Select All

Selects all the text in the topmost editing window.

2.15  Window Menu

The Window menu offers the following commands, which enable you to arrange multiple
views of multiple documents in the application window:

2.15.1  Window / Cascade

Arranges the windows in an overlapping fashion, so that any window can be selected.



Chapter 2:  MODSIM Development Under Windows

31

2.15.2  Window / Tile

Arranges the windows so that each is visible, but none overlap.

2.15.3  Window / Duplicate

Makes a new editing window onto the same file as the topmost window.

2.15.4  Window / Close All

Closes all open windows.

2.15.5  Window / Output

Displays the Output window, which captures the output of the MODSIM compiler,
linker, etc.

2.16  Help Menu

The Help menu offers the following commands, which provide help with MODSIM III
Workbench questions.

2.16.1  Help / MODSIM Workbench Help

Displays the table of contents to the MODSIM III Workbench Help.
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2.16.2  Help / Debugger Help

Displays the table of contents to the Debugging Help.

2.16.3  Help/MODSIM Library Help

Displays help on the MODSIM runtime and SIMGRAPHICS II libraries.

2.16.4  Help / Using Help

Gives instructions on using Windows Help.

2.16.5  Help / About ModBench

Choosing About ModBench from the Help menu, or selecting it from the toolbar, brings
up a dialog box that gives the version and copyright of MODSIM III Workbench.

2.17  The Workbench Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.
The toolbar provides quick mouse access to many tools used in MODSIM III Work-
bench.

To hide or display the Toolbar, choose Toolbar from the View menu.

Click To

Open a new document.  A shortcut for File/New.

Open an existing document.  A shortcut for File/Open.

Save the active document or template with its current name. A shortcut for
File/Save.

Remove selected data from the document and store it on the clipboard.  A short-
cut for Edit/Cut.

Copy the selection to the clipboard.  A shortcut for Edit/Copy.

Insert the contents of the clipboard at the insertion point.  A shortcut for
Edit/Paste.

Build the project.



Chapter 2:  MODSIM Development Under Windows

33

Re-build all modules in the project.

Stop Build at next opportunity.

Print the active document.  A shortcut for File/Print.

Displays the About box.

Initiates Context Sensitive Help.

2.18  The Workbench Status Bar

The status bar is displayed at the bottom of the MODSIM III Workbench window.  To
display or hide the status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys
to navigate through menus.  This area similarly shows messages that describe the actions
of toolbar buttons as you depress them, before releasing them.  If after viewing the de-
scription of the toolbar button command, you wish not to execute the command, release
the mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAPS The Caps Lock key is latched down.
NUM The Num Lock key is latched down.

The rightmost windows indicate the line and column number of the active edit window.

Context Help Command

   Use the Context Help button to obtain help on some portion of MODSIM III
Workbench.  When you choose the Toolbar's Context Help button, the mouse pointer
will change to an arrow and question mark.  Then click somewhere in the MODSIM III
Workbench window, such as on another Toolbar button.  The Help topic will be shown
for the item you clicked.  Shortcut:  Keys:  SHIFT+F1

Title Bar

The title bar is located along the top of a window.  It contains the name of the application
and document.

To move the window, drag the title bar.

 Note: You can also move dialog boxes by dragging their title bars.  A title bar may
contain the following elements:
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• Application Control-menu button

• Document Control-menu button

• Maximize button

• Minimize button

• Name of the application

• Name of the document

• Restore button

Scroll Bars

Displayed at the right and bottom edges of the document window.  The scroll boxes in-
side the scroll bars indicate your vertical and horizontal location in the document.  You
can use the mouse to scroll to other parts of the document.

Size Command (System Menu)

Use this command to display a four-headed arrow so you can size the active win-
dow with the arrow keys.  After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left-, right-, up-, or down-arrow key)
to move the pointer to the border you want to move.

2. Press a DIRECTION key to move the border.

3. Press Enter when the window is the size you want.

Note:  This command is unavailable if you maximize the window.

Shortcut:  Mouse: Drag the size bars at the corners or edges of the window.

Move Command (System Menu)

Use this command to display a four-headed arrow so you can move the active
window or dialog box with the arrow keys.

Note:  This command is unavailable if you maximize the window.

Shortcut:  Keys: CTRL+F7

Minimize Command (System Menu)

Use this command to reduce the MODSIM III Workbench window to an icon.

Shortcut: Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9

Maximize Command (System Menu)

Use this command to enlarge the active window to fill the available space.
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Shortcut: Mouse: Click the maximize icon  on the title bar; or double-click the
title bar.
Keys: CTRL+F10 enlarges a document window.

Next Window Command (Document System Menu)

Use this command to switch to the next open document window. MODSIM III Work-
bench determines which window is next according to the order in which you opened the
windows.

Shortcut:  Keys: CTRL+F6

Previous Window Command (Document System Menu)

Use this command to switch to the previous open document window.  MODSIM III
Workbench determines which window is previous according to the order in which you
opened the windows.

Shortcut:  Keys: SHIFT+CTRL+F6

Close Command (System Menu)   

Use this command to close the active window or dialog box.  Double-clicking a System-
menu box is the same as choosing the Close command.

Shortcuts:  Keys:  CTRL+F4 closes a document window.
 ALT+F4 closes the window or dialog box.

Restore Command (System Menu)

Use this command to return the active window to its size and position before you chose
the Maximize or Minimize command.

Switch to Command (Application System Menu)

Use this command to display a list of all open applications.  Use this "Task List" to
switch to or close an application on the list.  Shortcut:  Keys:   CTRL+ESC
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3.  The MODSIM III Debugger

MODSIM III provides built-in debugging capabilities to your application. You can either
start up your application in debugging mode or execute it normally, allowing MODSIM
to drop you into debugging mode if a runtime error occurs.  Unlike conventional debug-
gers, it is not necessary to restart your application under control of a debugger to deter-
mine the cause of an error.  Once your application has entered debugging mode, you can
examine variables, browse up and down the execution stack, print simulation statistics,
memory usage, etc.  If you enter into debugging mode before a fatal error occurs, you
can have full control of what points in the code you wish to stop at for more detailed ex-
amination or can set up automatic watching of chosen variables.

Enabling debugging support in your MODSIM III program has minimal impact to either
compile-time or runtime performance.  It is convenient to leave debugging enabled
throughout the development phase of writing an application.  Then when you are con-
vinced that the program is correct,  you can recompile the entire application without de-
bugging support.

There are some differences between debugging on Microsoft Windows systems and
on Unix systems.  On MS Windows systems you can enter debugging commands
through the graphical user interface.  On Unix systems, you enter debugging com-
mands at the command line.  These commands also work on MS Windows systems,
and are entered via a command line window at the bottom of the debugging win-
dow (see figure below).  In what follows, we distinguish between what applies to MS
Windows systems only (labelled MS Windows) and what applies everywhere
(labelled Unix).
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3.1  Basics

To debug your program:

1. Compile your main module and any other modules you desire with debugging
support enabled.  This procedure is described in detail in paragraph 3.3 below.

2. On systems running Microsoft Windows 95 or NT, select Debug from the Project
menu of MODSIM III Workbench.  On other systems, you debug a program by
giving it the argument "-msdebug" when you start it up .  A DOS window may
be opened and the program name entered with -msdebug as a parameter; a Re-
turn will then cause the program to execute with the debugger active.  If your
program also has arguments, you can place the "-msdebug" flag before, after, or
in the middle of the other arguments to your program.  The flag will be stripped
away before your program sees it.

Your program will stop at the first executable statement in your code including the mod
inits (these may be stepped over with the “continue” command or stepped into using
the “step in” command, displaying the debugger graphical interface. You can either
use the command line interface or, in Windows, use the Tool palette and dialogs to con-
trol the debugger.
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Essential commands for the command line interface are:

• step :  continue to next executable line, stepping into procedures
• next :  continue to next executable line, stepping over procedures
• continue :  continue to the next breakpoint
• break : set a breakpoint at the current line, at a function entry, or at a specified

line number
• traceback :  show the calling chain that led to the current method or procedure
• print <variable name> :  print the value of a variable
• locals  :  show all of the local variables
• fields  :  show all of the fields of the object that is currently executing.

Most Microsoft Windows users will opt to use the Tool palette to control execution and
to set and clear breakpoints with the click of a mouse.

3.2  Interfacing with the Debugger

You can control the execution of your program and examine its state either through the
graphical interface  (on MS Windows systems) or a command line interface (available on
all systems).

Unix

Most commands entered into the command line interface can be shortened or abbrevi-
ated.  The command reference provides details for each individual command.  For in-
stance, disable breakpoint can be abbreviated as d or show modules can be
shortened to sh m.

All command line interface commands are terminated by a carriage return. A carriage
return by itself has a special significance.  Its general meaning is to do the  next logical
thing.  For instance, a carriage return entered by itself after a list command will cause
additional source code to be displayed from the source code line where the previous list-
ing ended.  Typically, a carriage return by itself will repeat the previous command.  For
instance, after entering a step command, additional step commands can be generated
by pressing carriage returns.

MS Windows

The main dialog has one primary window and a movable Toolbar palette of debugger
commands. The MODSIM Debugger window (shown above) displays the code which is
currently executing, the currently selected stack frame, or code which you are navigating
through. A command line interface window appears at the bottom of the primary window
and allows entering commands directly.  A trace log of all issued debugger commands
and their results is copied to the file msdebug.tra .  This provides a log of the entire
debugging session.

The  buttons Step In, Step Over, Step Out and Continue on the Toolbar palette (shown
below) perform identically to entering the corresponding commands step, next, ste-
pout and continue from the command line interface.
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3.3  Compiling for Debugging

MS Windows

From the MODSIM Workbench Menu select Project  and then Settings … .

A tabbed window will appear which contains a number of compilation, linking and de-
bugging settings.  These settings will be used by the various tools in the creation of an
executable module.  Note that the three radio buttons on the top indicate whether the
code will be compiled and linked with debugging on or for release (debugging sup-
pressed).
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When the Debug Specific tab is selected, even more granularity regarding the code being
compiled can be selected.  This includes the level of error messages and range checking.
These selections control the amount of code placed in the executable as debugger runtime
libraries and may affect execution performance.
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Unix

On other systems, enable debugging support with mscomp or edit the mscomp.cfg file
to turn debugging support on in mscomp.

To terminate your program use the quit command.

3.4  Examining Memory and Simulation Statistics

MS Windows

To browse the pending list of scheduled activities, select Info and then Pending List from
the main menu in the MODSIM III Debugger window.
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By selecting First, Next, Last, and GoTo, you can browse up and down the pending list.
To examine all of the fields of the object whose activity is being viewed, select View
Object.
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Unix

Simulation time can be printed by using the command line interface command simtime.
The pendinglist command prints the entire list of pending activities.  An aid to de-
bugging memory leaks is the memstats command. It displays a list of all the objects,
records, and strings which have been allocated.  A copy of the list is also written to the
file "msdebug.mem".

3.5  Running

MS Windows

If you start your application in debugging mode, you can control its execution either
from the Toolbar palette or from the command line interface.  The Toolbar palette has the
buttons Step In, Step Out, Step Over, and Continue.  The corresponding command line
interface commands are step, stepout, next, and continue .

Unix

Use step if you just wish to execute the next executable line.  If the next executable line
is a procedure or method call, then the step command will cause the program to stop at
the first line of that procedure or method.  However, if you  do not wish to stop in a
called procedure or method, then use the next command.  Both step and next will
take an integer argument which specifies how many lines to execute.  For instance, you
can stop at the fifth line from the current location by using next 5.

The continue command will cause your program to stop at the next breakpoint.
Breakpoints can be added with the break command, clicking on a line in the source
window, or by using the Breakpoints dialog box.

To terminate your program use the  quit  command.
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3.6  Setting Breakpoints

MS Windows

Setting a breakpoint can be accomplished by clicking on a line in the source window, by
using the Breakpoints dialog box, or by using the break command .

Unix

At the command line, you can create a breakpoint by specifying a line number or the en-
try point of a procedure or method. Assuming there is a method named foo in an object
type myObjectType which has been defined in the module name myModule, you can
explicitly set the breakpoint at the first executable line of foo by entering the command :

break myModule.myObjectType.foo.

If an explicit description of the breakpoint location is not given, then the current context
is used to fill in the missing details. For instance, if you enter break foo, then a break-
point will be set at the method foo, if the currently executing object has such a method.
If it does not, then it will try to set a breakpoint at a procedure named foo.

At any time you can view the breakpoints which are currently in effect by using the
Breakpoints dialog box.  If you want to delete an existing breakpoint, select the break-
point and press the Delete button. If you want to disable or enable an existing breakpoint,
simply double click on it.

3.7  Examining Source Code

MS Windows

Every time your program stops, the currently executing code is displayed in the source
window. You can browse other source code by selecting the desired module, object type,
and method in the source code selector.  Otherwise, you can use the cursor bar to scan
through the source code in the currently displayed module.
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If the source window is empty except for line numbers, it is probably because the debug-
ger is not able to find the source code.   In this case, use the option (or the dir) com-
mand to specify the source code directory.

Unix

Every time your program stops, the debugging window will display the next MODSIM
statement that will be executed.  In order to display the surrounding source code or to
display source code in another module or procedure, use the list command. If the list
command cannot find the source file, then the directory to find source files must be
added to the source file search path using the option  command.

3.8  Examining Variables

MS Windows

There are various facilities available for examining the values of variables.  If you want
to see all of the local variables, use the Locals button in the Toolbar palette or use the
locals command.  To see all of the fields of the currently executing object, use the
Fields button in the Toolbar palette.

Note:  Double clicking on an object or a dynamic record in any of the variable inspector
dialog boxes will cause that object or record to expand, displaying all of its fields.  A
subsequent double click will cause it to contract.

Unix

If you want to see all of the local variables, use the locals command.  To see all of the
fields of the currently executing object,  enter fields on the command line. If you want
to see all of the fields of an object which is not the currently executing object use the
print command.  For instance, if there is an object named myInstance visible in the
current scope, then you can print all of its fields by entering the command print my-
Instance.  To print the value of a single variable, use the print command (i.e. print
myVariable).  If myVariable is the field of the object named myObject, then enter
the command print myObject.myVariable.

3.9  Examining the Stack

Often when debugging, you want to know what was the sequence of the procedure or
method calls which led to the current piece of code that is being executed.  This informa-
tion is continuously available in the Call Stack box in the main MODSIM Debugger win-
dow.  You can also use the command line interface traceback command to print the
call stack.  This requested information is appended to the file msdebug.tra.  The
methods and procedures which comprise the call chain are numbered starting at 0 for the
current method or procedure and ending at main with the highest number.
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For a more in-depth examination of any of the methods or procedures on the stack, use
up, down, and frame commands to focus on a particular frame.

3.10  Recording and Playing Back Commands

It is often a good idea to record all of the debugging commands that are entered in a de-
bugging session. Once you discover a bug, you can fix it, and then verify that the fix was
successful by playing back the sequence of commands that originally uncovered the bug.

The record command copies all of the commands that you subsequently enter to a file.
To playback these commands use the playback command.

3.11  Specifying Source File Search Path

The debugger keeps a list of directories which contain debuggable source code for a pro-
gram.  To add directories to this list, use the option (or the dir) command.



MODSIM User's Manual

48

3.12  Animating Code Execution

To watch source code as your program is executing, simply issue a step command with
a large argument (e.g. 1000).  The debugging display window will indicate every context
change and each line of source code as it is being executed.

3.13  Displaying Methods of an Object Type

Use the print command to display all of the methods of an object type.  For example, if
there is an object type myObjectType in your program, enter the command print
myObjectType.

3.14  Displaying Fields of an Object Instance

The fields window is constantly updated with the fields of the object that is currently
executing or with the object which is in focus as a result of selecting another method on
the call stack . Use the show fields command to print all of the fields of an object in-
stance to the transcript window.  The print command can be used to display the fields
of an object that is in the scope of the current context. For example, print myObject
will print all of the fields of myObject, if it is a local variable, a field of the object that
is currently executing, or a global variable.  print SELF will generate the same result
as show fields.
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3.15  Command Reference

Break

Synopsis:

Creates a breakpoint at a specified source location.

Abbreviations:
b, br,  break, brkpt

Usage:
break

break <method or procedure name>

break <module name>.<procedure name>

break <module name>.<object type>.<method name>

break <line number>

break <module name> <line number>

Notes:

To set a breakpoint at the next executable line, use break without any argu-
ments.  If a line number is specified without any module name, then a break
point will be set in the module that has source code for the current context.

If the name of a procedure and method name is specified, then a break point
will be set at the first executable line of the method or procedure. You can
forego a complete specification of the module name and object type name if
the method that you want to break in is a member function of the currently
executing object.

Continue

Synopsis:

Continues execution until the next breakpoint.

Abbreviations:
c, cont, continue

Usage:
continue

continue <number of breakpoints to ignore>
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Notes:

The continue command will cause the program to stop at the next break-
point if no optional argument is given.  Otherwise, the specified number of
breakpoints will be ignored.

Delete

Synopsis:

Deletes a breakpoint.

Abbreviations:
de, del, delete

Usage:
delete

delete all

delete <break point id>

Notes:

The delete command will permanently remove a breakpoint from the list of
breakpoints for your program.  It cannot be restored with the enable com-
mand.

Entering delete or delete all will permanently remove all of break-
points which have been previously defined.

Disable

Synopsis:

Disables a breakpoint.

Abbreviations:
d, di, dis, disable

Usage:
disable

disable all

disable <breakpoint id>

Notes:

Entering disable or disable all will disable all of the breakpoints which
have been set in your program.  To disable a particular breakpoint, find its id
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using the show breakpoints or Show_Breakpoints command.  Then
give the id as an argument to the disable command.

Down

Synopsis:

Moves the focus context forward in the calling chain towards the method or
procedure that is currently executing.

Abbreviations:
dn, down

Usage:
down

down <number of frames>

Notes:

Down moves the focus context forward in the calling chain toward the
method or procedure that is currently executing.   By giving an argument to
the command, you can make larger jumps down the stack. Up is used in con-
junction with down to browse up and down the stack.

Enable

Synopsis:

Enables a particular breakpoint or all breakpoints.

Synonyms and Abbreviations
e, en, enable

Usage:
enable <breakpoint id>

enable

enable all

Notes:

To enable a particular breakpoint, you must use its breakpoint id.  This can be
found by using show breakpoints (abbreviated to sh b, if desired). To
enable all breakpoints, just use enable by itself or append the keyword all
(i.e. enable all).



MODSIM User's Manual

52

Fields

Synopsis:

Displays all the fields of the object which is currently executing.

Abbreviations and synonyms
fields, fi, sh fields, info fields, show fields

Usage:
fields

Notes:

If the current context is a method, then all of the fields of the object will be
displayed.  Otherwise, an error message will indicate that the current context is
not a method.

Frame

Synopsis:

Sets the focus context to a particular stack frame.

Abbreviations:
f, fr, frame

Usage:
frame

frame <frame number>

Notes:

Entering frame without any arguments, sets the focus context to frame 0 and
displays all of its local variables.  Otherwise, by giving an argument to the
frame command, you can set the focus context to any particular frame.

Globals

Synopsis:

Displays all of the object types, record types, constants,  free procedures, and
module level variables in your program.

Abbreviations:
g, gl, glo, globals, shg, info globals, show globals
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Notes:

This command displays all of the outer level symbols visible in the modules
which have been compiled with debugging.  If an object type that you are in-
terested in debugging is not displayed in this list, then you must compile its
module with debugging before you will be able to examine its fields or step
through its methods.

List

Synopsis:

Lists source code.

Abbreviations:
l, li, list

Usage:
list

list <method or procedure name>

list <module name>.<procedure name>

list <module name>.<object type>.<method name>

list <line number>

list <starting line number> <ending line number>

Notes:

Normally, the debugger looks for source code in the directory specified when
the module was compiled.  If the program or the source files were moved to a
different directory, then the debugger will not know where to find them.  In
this case use the option command to add an additional search path for source
files.

To list the source code that is currently being executed, simply use the list
command without any arguments.  By specifying a procedure or method name,
the first twenty lines of that method or procedure will be listed.  Entering a
carriage return will cause the next twenty lines of source code to be displayed.

A line number can also be specified as the source location that you would like
to view.  In this case, the display will be centered around the line you speci-
fied.

If you want to list the source code of the method that called the current proce-
dure, first use the up  command to move up one stack frame and then issue the
list command.
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Locals

Synopsis:

Displays the values of local variables in the current context.

Abbreviations and synonyms
lo, locals, show locals, info locals

Usage:
locals

Notes:

Typically, show locals will display the local variables of the currently exe-
cuting method or procedure (i.e. frame 0). More precisely, show locals will
display all of the local variables of whatever frame is in focus.  If an up,
down, or frame command had been invoked prior to show locals, then the
context that is in focus may be something other than frame 0.  Immediately
after any code has been executed, the focus always returns to frame 0.

Memstats

Synopsis:

Displays a list of the number of allocated instances of all object and record
types, strings, and arrays in your program.

Abbreviations:
me, mem, memstats

Notes:

This command is very useful in discovering memory leaks in your program.
By occasionally issuing this command and comparing  results, it will become
apparent if some objects are not being disposed of properly.  A copy of this list
will automatically be saved in the file "msdebug.mem", so that you can study
it later, if necessary.
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Next

Synopsis:

Stops program execution at the next executable line, stepping over procedures.

Abbreviations:
n,ne,nex,next

Usage:
next

next <number>

Notes:

Use the next command if you do not want to step into called methods or pro-
cedures.

Option

Synopsis:

Sets a debugging environment variable to a new value.

Abbreviations:
opt, option

Usage:
option <variable name> = <new value>

Debugging Environment Variables:

sourcedirectory
MODSIM keeps a list of directories which contain debuggable source code for
a program.  Normally, the only directory in this list is the directory that you
specified in MODBENCH when you compiled your program.  However, if
you changed the location of your source code or your program,  then
MODSIM may not be able find your source code.  Setting the sourcedirec-
tory variable will add that directory as the first directory to search when
looking for source code modules.  Make sure that the source modules have not
changed since your program was compiled.  Otherwise, what MODSIM re-
ports to be the next executable line may not correspond with what your pro-
gram is actually doing.  As a convenience, you can abbreviate the command
string option sourcedirectory = <new directory> to dir <new
directory>.
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 Pendinglist

Synopsis:

Displays a list of all of the objects which have activities scheduled on the
pending list.

Abbreviations:
pe, pl, pending, pendinglist

Notes:

This command simply calls the MODSIM PendingListDump procedure.  A
copy of the pending list is also copied to the file msdebug.pen for later
viewing.

Playback

Synopsis:

Executes debugging commands from a file.

Abbreviations and Synonyms:
pl, play, playback, readcmd, readcmds, replay

Usage:
playback

playback <filename>

Notes:

If no filename is given, commands will be executed from the file msde-
bug.log, if it exists.  As soon as all of the commands in the file have been
executed, you can issue commands from the command line or by pressing one
of the execute buttons: Step, or Next.

Print

Synopsis:

Outputs the value of a variable or information about a type.

Abbreviations :
p, print

Usage:
print <identifier>
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print <object or record instance>.<field 
identifier>.<field identifier> etc.

print <object type name>

Notes:

The current context is used to identify the variable.  The identifier is searched
for first in the local scope, then object scope, and finally in global scope.  If
the identifier is an object type, all of the methods of the object class will be
displayed.  If the identifier is an object instance, then the values of all of the
fields of the object instance will be displayed.

To display the field of an object which is a field of another object which is a
field of yet another object use the . notation
(i.e. print object.anotherObject.field).

Quit

Synopsis:

Quits the program.

Abbreviations and Synonyms:
q, quit, bye, exit

Notes:

The quit command terminates your program.  If there are breakpoints or en-
vironmental variables that you would like to preserve over various debugging
sessions, you can save the appropriate commands in a file and use the         
playback command to reinstall them for each debugging session.

Record

Synopsis:

Records all of the commands entered in a debugging session to a file.

Abbreviations and Synonyms:
rec, record, log

Usage:
record

record <filename>
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Notes:

Recording a log of all commands issued in a debugging session is a convenient
way to return to the location of a previous bug. After you have fixed the bug,
simply play back the log file using the playback command. This will help
verify that the fix was indeed successful.

Show Breakpoints

Synopsis:

Displays all of the breakpoints and their status.

Abbreviations and Synonyms:
shb, info breakpoints, show breakpoints

Notes:

Breakpoints are given a unique id when they are created.  The id is used to
specify a breakpoint that you wish to disable, enable, or delete.

If you wish to set certain breakpoints every time you debug a particular pro-
gram, you can create a command file with the name msdebug.ini in the
working directory.  Each line of the command file should contain a break
command with an explicit description of where you want to break.  This com-
mand file can be created with a text editor or by using the record command.

Show Modules

Synopsis:

Displays all of the modules and the pathnames of the Implementation modules
in your program.

Abbreviations:
shm, sh modules, info modules, show modules

Usage:
show modules

Notes:

This command will display where MODSIM currently thinks the source code
for your program is located.  If this is incorrect, you can specify where to find
source code with the option sourcedirectory option command.
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Simtime

Synopsis:

Displays the current simulation time.

Abbreviations:
sim, time, simtime

Step

Synopsis:

Stops program execution at the next executable line, stepping into procedures.

Abbreviations:
s,st,ste,step

Usage:
step

step <number>

Notes:

Use the step command if you want to step into called methods or procedures.
Unlike the next command, the step command will cause the program to stop
in a called procedure. An integer argument after step instructs MODSIM to
execute the step command <number> times. Giving a large number as an ar-
gument to the step command creates an animation effect. This is particularly
useful in graphical simulation applications, since you can watch the graphics
animation in one window and the corresponding code being executed in an-
other window.

Traceback

Synopsis:

Displays the program stack.

Abbreviations and Synonyms:
t,tb,bt,back,where,backtrace,stack,traceback,calls

Notes:

The traceback displays a list of the methods and procedures on the program
execution stack.  These frames are numbered starting at 0 with the method or
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procedure which is currently executing.  The highest numbered frame is main
which is the code in the MAIN MODULE between BEGIN and END MODULE.

To display the values of local variables in a particular frame, use the frame or
up or down commands to focus on that frame. The fields command will
display all of the object fields if the frame is an object method.

Up

Synopsis:

Moves the focus context backwards in the calling chain towards main.

Abbreviations:
u, up

Usage:
up

up <number of frames>

Notes:

To find the procedure or method that called the current procedure or method,
use the up command.  By giving an argument to the command, you can make
larger jumps up the stack. Up is used in conjunction with down to browse up
and down the stack.
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4.  Command Line Interface to MODSIM III
Compiler

The MODSIM III compiler was designed to be managed by the mscomp compilation
manager. The manager provides a high level Graphical User Interface (GUI).  There may
be occasions when you require direct access to the MODSIM III compiler.  This chapter
documents the command line interface to the compiler for such situations

The procedure would be as follows:

• Compile MODSIM source code to C++ using the command line interface to the
MODSIM compiler.

• Using mscomp's Other option, perform a single-module compile of the C++
code.

• Using mscomp's Other option, perform a Link All to build an executable.

You give up the interactive support of mscomp but gain the ability to operate on a ma-
chine with limited memory availability

4.1  MODSIM III Compiler Command Line Options

Usage:  modsim <options> <imod>

Directory options:

-i <dir> = search this directory for local imp modules
-d <dir> = search this director for local def modules
-L <dir> = search this directory for def mods, this option can be repeated for

 multiple directories.

Code Generation options:

-T   = generate indented code
-H   = generate header file only

Debugger options:

-t0   = no debugging
-t1   = minimal debugging (traceback only)
-t2   = partial debugging (library browse)
-t3   = full debugging
-s     = turn OFF subrange checking
-r     = turn OFF reference checking
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General options:

-W0            = no compiler warnings
-W1 to 5     = set compiler warning level

4.2  An Example of Command Line Compilation

To compile the MODSIM module ITank.mod which is located in a directory above the
current working directory.

On PC:

> modsim3 -t3 -T -L c:\modsim\fulldef -d .. .. \ITank.mod

On UNIX:

> modsim -t3 -T -L /installed/modsim3/lib -d  .. ..
/ITank.mod
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5.  MODSIM III’s Standard Modules

MODSIM supports the following standard modules:

OSMod Operating System interface

SimMod Simulation objects and procedures

RandMod Random number objects and procedures

GrpMod Group objects and procedures

IOMod IO objects and procedures

UtilMod Utility procedures

MathMod Math support procedures

Debug Support utilities and metrics for debugging.

StatMod Simulation statistics objects and procedures

ResMod Resource object support for simulation
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